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1 INLEIDING 

Deze handleiding beschrijft beknopt de stappen die men moet volgen om .shp-bestanden te converteren van 
Lambert72 naar Lambert2008 aan de hand van de actuele en meest accurate transformatiemethode, zijnde die 
met de EPSG-code 8369 (EPSG-naamgeving: “BD72 to ETRS89 (3)”). Deze methode maakt gebruik van het meest 
recente NTv2-rooster, dat ontwikkeld werd door N. Simon (SPW) in 2017 en gevalideerd door het NGI. 

EPSG definieert ook twee andere transformatiemethodes, nl. 

• “BD72 to ETRS89 (1)”, EPSG-code: 1652 

• “BD72 to ETRS89 (2)”, EPSG-code: 15928 

Deze twee methodes zijn ook beschikbaar in GIS maar zijn verouderd en minder accuraat (gedocumenteerde 
accuraatheid tot op 1 m). 

2 ARCGIS 

2.1 MODULE “COORDINATE SYSTEMS DATA” 

In ArcGIS Pro en ArcMap zijn standaard twee transformatiemethodes gedefinieerd om data van Lb72 te 
transformeren naar Lb08 en vice versa, nl. ‘Belge_1972_To_ETRS_1989_1’ en ‘Belge_1972_To_ETRS_1989_2’. 
Deze komen overeen met respectievelijk EPSG:1652 en EPSG:15928. Vermits deze niet up-to-date zijn met het 
meest recente NTv2-rooster, stelde ESRI BeLux een nieuwe transformatiemethode ter beschikking onder de 
noemer ‘Belge_1972_To_ETRS1989_3’. Deze methode hanteert exact dezelfde parameters als EPSG:8369 
(“BD72 to ETRS89 (3)”)1 en het gebruik hiervan wordt hieronder beschreven. 

De methode is nog niet standaard geïmplementeerd in de ArcGIS Pro en ArcMap software. Om deze te kunnen 
gebruiken, dient men daarom eerst nog de module ‘ArcGIS Coordinate Systems Data’ te downloaden en te 
installeren. Om dit proces te doorlopen, wordt verder verwezen naar volgende instructies, opgesteld door ESRI 
BeLux: https://esribelux.com/omzetting-van-ntv2-du-datum-belge72-naar-datum-etrs89-beschikbaar/?lang=nl  

Na installatie wordt de transformatiemethode ‘Belge_1972_To_ETRS1989_3’ beschikbaar. De module is enkel 
beschikbaar voor de ArcGIS Software releases sinds 2019: 

• Voor ArcGIS Pro: Versie 2.4 en volgende  
• Voor ArcMap: Versie 10.7 en volgende 

 

1 Momentel zijn gesprekken lopende met ESRI door het NGI en SPW om de officiële EPSG-naamgeving te integreren in ArcGIS Pro en ArcMap 

https://vlaamseoverheid.atlassian.net/wiki/spaces/LAM/pages/6066778920
https://vlaamseoverheid.atlassian.net/wiki/spaces/LAM/pages/6066778920
https://esribelux.com/omzetting-van-ntv2-du-datum-belge72-naar-datum-etrs89-beschikbaar/?lang=nl
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2.2 ARCGIS PRO 

De actuele transformatiemethode (EPSG: 8369, in ArcGIS Pro onder de naam “Belge_1972_to_ETRS_1989_3”) is 
niet standaard geïmplementeerd in ArcGIS Pro. De andere standaard geïmplementeerde transformatiemethodes 
zijn verouderd en minder accuraat; het gebruik ervan wordt daarom afgeraden. Download en installeer daarom 
eerst de “ArcGIS Coordinate Systems Data”-module (zie 1.1) om EPSG:8369 te kunnen gebruiken binnen ArcGIS 
Pro 

2.2.1 Conversie van individuele .shp-bestanden 

Volgende stappen dienen doorlopen te worden om een individueel .shp-bestand te converteren van Lambert72 
naar Lambert2008. 

1. Laad het .shp-bestand op in een ArcGIS Pro-project. 
2. Open de geoprocessing tool ‘Project’. 
3. Selecteer de laag die u wilt converteren onder “Input Dataset or Feature Class”. 
4. Geef onder “Output Dataset or Feature Class” de naam (en eventueel locatie) in waaronder u het nieuwe 

bestand (dit is het bestand in Lb08) wilt opslaan.  
5. Klik op “Select coordinate system” (het wereldbol-icoontje).  

 

6. Zorg ervoor dat het veld “Current XY” geselecteerd is en geef in de zoekbalk “Lambert 2008” in. Het 
coördinatensysteem “Belge Lambert 2008” kan nadien snel teruggevonden worden onder Projected 
coordinate system > National Grids > Europe > Belge Lambert 2008. 
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7. Klik op het coördinatensysteem “Belge Lambert 2008”. Hierdoor verschijnt “Belge Lambert 2008” onder 
“Current XY”. Het veld bij “Current Z” mag leeg gelaten worden. Bevestig met “OK”. 

8. Controleer of de transformatiemethode “Belge_1972_To_ETRS_1989_3” is geselecteerd onder 
“Geographic Transformation”. 

9. Indien de geselecteerde input-laag lijnendata of polygoondata bevat, is de optie ‘Preserve Shape’ 
zichtbaar. Laat deze optie uitgevinkt staan. 

10. Klik op “Run”. 
11. Het bestand werd geconverteerd naar een nieuw bestand met Lb08 als CRS. 

2.2.2 Conversie van meerdere .shp-bestanden in bulk 

1. Laad de .shp-bestanden op in een ArcGIS Pro-project. 
2. Navigeer naar de Geoprocessing Toolbox (“Analysis” > “Tools”) en zoek de “Project” geoprocessing tool. 

Open de tool niet, maar rechterklik op “Project” en kies “Batch”. 

 De methodes “Belge_1972_To_ETRS_1989_1” (EPSG:1652) en “Belge_1972_To_ETRS_1989_2” 
(EPSG:15928) zijn verouderd en doen geen beroep op het meest recente NTv2-rooster (EPSG: 8369). 
Het wordt afgeraden om deze methodes te gebruiken. 

 Indien “Belge_1972_To_ETRS1989_3” niet beschikbaar is, is er mogelijk iets fout gelopen met de 
installatie van de ArcGIS module “ArcGIS Coordinate Systems Data” (zie 2.1). 
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3. Laat alle instellingen staan en klik op “Next”. 
4. Selecteer onder “Batch Input Dataset or Feature Class” de lagen die u wenst te converteren. 

5. Navigeer onder “Output Dataset or Feature Class” naar de locatie waar u de nieuwe bestanden in Lb08 
wenst op te slaan. Eens genavigeerd naar de desbetreffende locatie, geeft u onder “Name” het 
naamformaat in waaronder u de verschillende .shp-files wilt aanmaken. Aangezien ArcGIS Pro de 
geconverteerde output opslaat naar telkens dezelfde naam, dient u bij “Name” een dynamische naam 
te kiezen (die wijzigt bij ieder te converteren .shp-file). Dit doet u door de karakters “%Name%” toe te 
voegen, zie als voorbeeld onderstaande afbeelding. ArcGIS Pro zal de karakters %Name% bij elke 
conversie vervangen door de originele naam van de input .shp-files. Zo krijgt elk nieuw aangemaakt 
bestand een naam die 1 op 1 te linken is aan het input bestand.  

 

6. Klik op “Save”. 
7. Klik onder “Output Coordinate System” op “Select coordinate system” (het wereldbol-icoontje).  
8. Zorg ervoor dat het veld “Current XY” geselecteerd is en geef in de zoekbalk “Lambert 2008” in. Het 

coördinatensysteem “Belge Lambert 2008” kan nadien snel teruggevonden worden onder Projected 
coordinate system > National Grids > Europe > Belge Lambert 2008. 

 Als u de “Batch Project” geoprocessing tool rechtstreeks opent, krijgt u niet de mogelijkheid om 
de transformatiemethode te kiezen. Het is enkel mogelijk om de transformatiemethode te kiezen als 
u Batch Project opent via rechtermuisknop op “Project” > “Batch”. 
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9. Klik op het coördinatensysteem “Belge Lambert 2008”. Hierdoor verschijnt “Belge Lambert 2008” onder 
“Current XY”. Het veld bij “Current Z” mag leeg gelaten worden. Bevestig met “OK”.  

10. Controleer of de transformatiemethode “Belge_1972_To_ETRS_1989_3” is geselecteerd onder 
“Geographic Transformation”.  

11. Indien de geselecteerde input-laag lijnendata of polygoondata bevat, is de optie “Preserve Shape” 
zichtbaar. Laat deze optie uitgevinkt staan. 

12. Klik op “Run”.  
13. De .shp-bestanden werden geconverteerd naar nieuwe .shp-bestanden met Lb08 als CRS. Met input 

bestanden “Lijnen.shp”, “Polgyonen.shp” en “Punten.shp” en een output naam gekozen als 
“%Name%_converted_to_Lb08 (zie stap 5) werden bestanden gegenereerd zoals getoond in 
onderstaande figuur. 

 

2.2.3 Conversie van Feature Datasets in File Geodatabases 

Een hele File Geodatabase kan nooit geconverteerd worden naar een ander CRS vermits het CRS niet 
gedefinieerd wordt op geodatabase niveau. Men kan wel de Feature Datasets, gedefinieerd binnen een File 
Geodatabase en dewelke meerdere Feature Classes kunnen omvatten, afzonderlijk naar een ander CRS 
converteren.  

 De methodes “Belge_1972_To_ETRS_1989_1” (EPSG:1652) en “Belge_1972_To_ETRS_1989_2” 
(EPSG:15928) zijn verouderd en doen geen beroep op het meest recente NTv2-rooster (EPSG: 8369). 
Het wordt afgeraden om deze methodes te gebruiken. 

 Indien “Belge_1972_To_ETRS1989_3” niet beschikbaar is, is er mogelijk iets fout gelopen met de 
installatie van de ArcGIS module “ArcGIS Coordinate Systems Data” (zie 2.1). 
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1. Navigeer naar de Geoprocessing Toolbox (“Analysis” > “Tools”) en open de “Project” geoprocessing tool.  
2. Navigeer onder “Input Dataset or Feature Class” naar de File Geodatabase waarin de Feature Dataset 

staat die u wenst te converteren. Selecteer de desbetreffende Feature Dataset.  
3. Navigeer onder “Output Dataset or Feature Class” naar de File Geodatabase waarin u de geconverteerde 

Feature Dataset wilt bewaren. Kies een naam voor de nieuwe Feature Dataset in het veld “Name”. De 
Feature Dataset kan in dezelfde File Geodatabase aangemaakt worden waarin de oorspronkelijke 
Feature Dataset beheerd wordt, maar u kan de Feature Dataset ook in een andere File Geodatabase 
opslaan. 

4. Volg dezelfde stappen als stap 5-8 in sectie 2.2.1. 
5. Indien de geselecteerde input Feature Dataset lijnendata of polygoondata bevat, is de optie “Preserve 

Shape” zichtbaar. Laat deze optie uitgevinkt staan. 
6. Klik op ‘Run’. 

 
7. De Feature Dataset in Lb08 is nu aangemaakt. 

2.3 ARCMAP 

De actuele transformatiemethode (EPSG: 8369, in ArcMap onder de naam “Belge_1972_to_ETRS_1989_3”) is 
niet standaard geïmplementeerd in ArcMap. De andere standaard geïmplementeerde transformatiemethodes 
zijn verouderd en minder accuraat; het gebruik ervan wordt daarom afgeraden. Download en installeer daarom 
eerst de “ArcGIS Coordinate Systems Data”-module (zie 1.1) om EPSG:8369 te kunnen gebruiken binnen ArcMap 

2.3.1 Conversie van individuele .shp-bestanden 

Volgende stappen dienen doorlopen te worden om een individueel .shp-bestand te converteren van Lambert72 
naar Lambert2008. 

1. Laad het .shp-bestand op in een ArcMap-project. 
2. Open de geoprocessing tool “Project (Data Management)” (“Geoprocessing” > “Search for Tools” en 

zoeken naar “Project (Data Management)”) . 
3. Selecteer de laag die u wilt converteren onder “Input Dataset or Feature Class”. 
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4. Geef onder “Output Dataset or Feature Class” de naam (en eventueel locatie) in waaronder u het 
nieuwe bestand (dit is het bestand in Lb08) wilt opslaan.  

5. Klik onder “Output Coordinate System” op het keuzelijst-icoontje.  

 

6. Zoek in de zoekbalk van de tab “XY Coordinate System” naar “Belge Lambert 2008” en bevestig met 
“OK”. 
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7. Controleer of de transformatiemethode “Belge_1972_To_ETRS_1989_3” verschijnt in het veld onder 
“Geographic Transformation (optional)”. Indien deze methode er niet staat, dient u ze zelf nog toe te 
voegen door ze te selecteren in de daarvoor voorziene dropdown-lijst.  

 

8. Indien de geselecteerde input-laag lijnendata of polygoondata bevat, is de optie ‘Preserve Shape’ 
zichtbaar. Laat deze optie uitgevinkt staan. 

9. Klik op “OK”.  
10. Het bestand werd geconverteerd naar een nieuw bestand met Lb08 als CRS.  

2.3.2 Conversie van meerdere .shp-bestanden in bulk 

1. Laad de .shp-bestanden op in een ArcMap-project. 
2. Navigeer naar “Geoprocessing” > “Search For Tools” 
3. Zoek de “Project (Data Management)” geoprocessing tool. Open de tool niet, maar rechterklik op 

“Project (Data Management)” en kies “Batch…”. 

 De methodes “Belge_1972_To_ETRS_1989_1” (EPSG:1652) en “Belge_1972_To_ETRS_1989_2” 
(EPSG:15928) zijn verouderd en doen geen beroep op het meest recente NTv2-rooster (EPSG: 8369). 
Het wordt afgeraden om deze methodes te gebruiken. 

 Indien “Belge_1972_To_ETRS1989_3” niet beschikbaar is, is er mogelijk iets fout gelopen met de 
installatie van de ArcGIS module “ArcGIS Coordinate Systems Data” (zie 2.1). 

 

https://vlaamseoverheid.atlassian.net/wiki/spaces/LAM/pages/6077646523/Conversiemethodes+in+GIS+Handleiding
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4. Voeg per laag die u wenst te converteren een rij toe aan de tabel via het “+”-icoontje. 

 

5. Doe voor elke laag (rij) het volgende: 

5.1. Rechterklik onder “Input Dataset or Feature Class” > “Open…”. Selecteer vervolgens het .shp-
bestand die u wenst te converteren, klik op “Add” en nadien op “OK”.  

5.2. Rechterklik onder “Output Dataset or Feature Class” > “Open…”. Selecteer vervolgens de 
locatie waar u het nieuwe bestand (Lb08) wil opslaan en kies een naam voor dit bestand. Klik 
nadien op “Save” en “OK”. 

5.3. Rechterklik onder “Output Coordinate System” > “Open…”. Klik op het keuzelijst-icoontje om 
het CRS “Belge Lambert 2008” te selecteren (idem aan stap 6 in 1.2.1). Klik “OK”, vervolgens 
“OK”.  
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5.4. Controleer of onder “Geographic Transformation” de transformatiemethode 
“Belge_1972_To_ETRS_1989_3” staat. Zoniet, rechterklik > “Open…” en selecteer 
“Belge_1972_To_ETRS_1989_3”.  

 

 

 

5.5.   Laat “Preserve Shape” op “false” staan, laat “Maximum Offset Deviation” leeg en laat ook
 “Vertical” op “false” staan.  

 

5.6.   Klik op “OK”. 
5.7.   ArcMap converteert de bestanden nu allemaal naar Lb08. Van zodra gereed, verschijnt er

 een melding rechtsonder en zijn de bestanden geconverteerd naar Lb08.  

2.3.3 Conversie van Feature Datasets in File Geodatabases 

Een hele File Geodatabase kan nooit geconverteerd worden naar een ander CRS vermits het CRS niet 
gedefinieerd wordt op geodatabase niveau. Men kan wel de Feature Datasets, gedefinieerd binnen een File 
Geodatabase en dewelke meerdere Feature Classes kunnen omvatten, afzonderlijk naar een ander CRS 
converteren.  

1. Open de geoprocessing tool “Project (Data Management)” (“Geoprocessing” > “Search for Tools” en 
zoeken naar “Project (Data Management)”). 

2. Navigeer onder “Input Dataset or Feature Class” naar de File Geodatabase waarin de Feature Dataset 
staat die u wenst te converteren. Selecteer de desbetreffende Feature Dataset. Klik op “Add”. 

3. Navigeer onder “Output Dataset or Feature Class” naar de File Geodatabase waarin u de 
geconverteerde Feature Dataset wilt bewaren. De Feature Dataset kan in dezelfde File Geodatabase 
aangemaakt worden waarin de oorspronkelijke Feature Dataset beheerd wordt, maar u kan de 
Feature Dataset ook in een andere File Geodatabase opslaan. Kies een naam voor de nieuwe Feature 
Dataset in het veld “Name”. Klik op “Save”.  

4. Volg dezelfde stappen als stap 5-7 in sectie 2.3.1. 
5. Indien de geselecteerde input Feature Dataset lijnendata of polygoondata bevat, is de optie “Preserve 

Shape” zichtbaar. Laat deze optie uitgevinkt staan. 
6. Klik op ‘OK’. 
7. ArcMap converteert de Feature Dataset nu naar Lb08. Van zodra gereed, verschijnt er een melding 

rechtsonder en is de Feature Dataset geconverteerd naar Lb08.  

 De methodes “Belge_1972_To_ETRS_1989_1” (EPSG:1652) en 
“Belge_1972_To_ETRS_1989_2” (EPSG:15928) zijn verouderd en doen geen beroep op het 
meest recente NTv2-rooster (EPSG: 8369). Het wordt afgeraden om deze methodes te 
gebruiken. 

 Indien “Belge_1972_To_ETRS1989_3” niet beschikbaar is, is er mogelijk iets fout gelopen 
met de installatie van de ArcGIS module “ArcGIS Coordinate Systems Data” (zie 2.1). 
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3 QGIS 

Om binnen QGIS herprojecties naar een ander CRS uit te voeren, doet QGIS beroep op de open source ‘PROJ’2-
toolkit.  

Er wordt aangeraden om met de meest recente versie van QGIS te werken. Deze bevat de actuele PROJ-toolkit 
met hierin de actuele transformatiemethode (EPSG:8369). Voor oudere versies kan dit niet gegarandeerd 
worden, en loopt men het risico gebruik te maken van een verouderde en minder accurate 
transformatiemethode (i.e. EPSG:1652 of EPSG:15928). Na installatie van de actuele QGIS-versie zou het NTv2 
rooster in .tif-formaat (‘be_ign_bd72lb72_etrs89lb08.tif’) aanwezig moeten zijn onder C:\Program Files\QGIS 
XX.XX.XX\share\proj.  

3.1 CONVERSIE VAN INDIVIDUELE .SHP-BESTANDEN 

Volgende stappen dienen doorlopen te worden om een individueel .shp-bestand te converteren van Lambert72 
naar Lambert2008. 

1. Laad het .shp-bestand op in een QGIS-project. 
2. Open de processing tool ‘Reproject Layer’. Deze kan geopend worden via 

• “Vector” > “Data Management Tools” > “Reproject Layer…”; of 

• “Reproject Layer” in de Processing Toolbox (“Processing” > “Toolbox”) 

3. Selecteer het bestand dat u wilt projecteren onder “Input layer”. 
4. Duid als Target CRS “EPSG:3812 - ETRS89 / Belgian Lambert 2008” aan.  

5. Klik ‘Advanced Parameters’ open en controleer of de transformatie ‘Inverse of unnamed + BD72 to 
ETRS89 (3) + Belgian Lambert2008’, met een accuraatheid (“Accuracy (meters)”) van 0,01 m geslecteerd 
is. Deze hanteert dezelfde parameters als EPSG:8369. Het is belangrijk om exact deze transformatie te 
gebruiken (met diezelfde accuraatheid), anders hanteert men een verouderde en minder accurate 
transformatiemethode.  

 
2 https://proj.org/ 

 Hoewel men bij aanduiden van “ESRI:102199 - Belge_Lambert_2008” als Target CRS ook de meest 
recente conversiemethode kan oproepen, wordt dit afgeraden. ESRI:102199 is immers niet het 
officiële Lambert2008 CRS. 
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6. Kies onder “Reprojected” de naam en locatie van het nieuwe bestand dat het resultaat is van de  
conversie.  

7. Klik op “Run”. 

8. De conversie is uitgevoerd.  

3.2 CONVERSIE VAN MEERDERE .SHP-BESTANDEN IN BULK 

1. Laad de .shp-bestanden op in een QGIS-project. 
2. Open de processing tool ‘Reproject Layer’. Deze kan geopend worden via 

• “Vector” > “Data Management Tools” > “Reproject Layer…”; of 

• “Reproject Layer” in de Processing Toolbox (“Processing” > “Toolbox”) 

3. Klik onderaan op “Run as Batch Process…”. 
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4. Klik op het “+”-symbool om nieuwe lagen toe te voegen.  

 

5. Specifieer onder ‘Input layer’ welke lagen dienen geconverteerd te worden. 
6. Specifieer voor elke laag de Target CRS waarheen geconverteerd moeten worden. Kies in dit geval 

telkens voor “EPSG:3812 - ETRS89 / Belgian Lambert 2008”. 

7. Specifieer voor elke laag onder “Reprojected” de naam en locatie van het nieuwe bestand dat het 
resultaat is van de conversie.  

8. Klik op “Run” 
9. De conversie is uitgevoerd voor elke laag. 

4 FME 

4.1 TRANSFORMERS IN FME VOOR DE CONVERSIE NAAR LB08 

In FME zijn verschillende transformers voorhanden om Lb72-data te converteren naar Lb08, namelijk 

• Reprojector 
o Versimpelde versie van CsmapReprojector 

 QGIS vraagt niet aan de gebruiker om te specifiëren welke transformatiemethode gebruikt dient 
te worden. QGIS hanteert namelijk de transformatiemethode van voorkeur (i.e. de 
transformatiemethode die standaard ook geselecteerd wordt in single modus, zie 3.1 stap 5). Indien 
gebruik wordt gemaakt van de meest recente uitvoering van QGIS, kan men er zeker van zijn dat deze 
transformatiemethode de actuele transformathiemethode is (i.e. EPSG:8369).  
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o Steunt op de OSGEO/FME CS-Map Library 
• CsmapReprojector 

o Steunt op de OSGEO/FME CS-Map Library 
• PROJReprojector 

o Vanaf FME 2021.0 hanteert deze transformer de actuele transformatiemethode (EPSG:8369) 
o Wordt verder beschreven 

• EsriReprojector 
o Zou de actuele transformatiemethode (EPSG:8369) ondersteunen, op voorwaarde dat het 

NTv2-rooster anwezig is op het systeem 
• ReprojMap_Belgian_Lambert72_to_Lambert2008 

o Aangeboden door het NGI via de FME Hub 
o Zou nog geactualiseerd worden door het NGI 

Voorlopig is het niet geweten of alle en welke transformers (M.u.z. van PROJReprojector) up to date zijn met 
de actuele transformatiemethode (EPSG:8369). 

4.2 CONVERSIE VAN INDIVIDUELE .SHP-BESTANDEN AAN DE HAND VAN 

DE PROJREPROJECTOR TRANSFORMER 

1. Zorg ervoor dat “Online Grids Enabled” aangevinkt staat onder “Tools” > “FME Options” > “Coordinate 
Systems” in het veld “PROJ”. Klik op “OK”. 
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2. Voeg de reader “Esri Shapefile” toe.  
3. Navigeer onder “Dataset” naar het te converteren .shp-bestand en klik op “OK”. 
4. Voeg de transformer “PROJReprojector toe”.  
5. Klik in de transformer op het tandwiel om de instellingen van de transformer te openen. 
6. Selecteer in het dropdown menu naast “Destination Coordinate System” “More Coordinate Systems…” 

om de Coordinate System Gallery te openen. Indien “ETRS89 / Belgian Lambert 2008 [EPSG:3812]” al 
in het dropdown menu verschijnt, kunt u deze selecteren in plaats van de Coordinate System Callery te 
openen en kan u stap 7 overslaan. 

7. Zoek en vind het CRS met naam “ETRS89 / Belgian Lambert 2008” en code “EPSG:3812” en klik op 
“OK”.  
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8. Klik op “OK”. 
9. Voeg de writer “Esri Shapefile” toe. 
10. Navigeer onder “Dataset” naar de locatie waar u het nieuwe bestand (in Lb08) wenst op te slaan.  
11. Selecteer onder “Coord. System” het CRS “EPSG:3812”. Indien dit niet in het dropdown menu 

aanwezig is, kunt u het vinden via “More Coordinate Systems…”. 

 

12. Klik op “OK”. 
13. Indien u de naam wenst aan te passen van het nieuwe bestand, klikt u op het tandwiel in de writer om 

de instellingen van de writer te openen. Vervolgens kiest u de nieuwe naam achter “Shapefile Name” 
en klikt u op “OK”. 

14. Verbind writer, transformer en reader met elkaar en voer de workbench uit door op “Run” te klikken.  
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15. Het bestand in Lb72 werd geconverteerd naar een nieuw bestand in Lb08.  

 

 


